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FEATURE ARTICLE

CIGNA LAUNCHES
FIVE-YEAR INITIATIVE TO
COMBAT SYSTEMIC RACISM

Cigna firmly denounces racism and discrimination in all forms, and is committed to confronting these issues
with intensity, empathy, and accountability. We have launched a five-year initiative to expand and accelerate
efforts to support diversity, inclusion, equality, and equity for communities of color. Its key components are

described below.

Improve health

There are striking differences in health outcomes

in communities with poor social determinants of
health, such as unstable housing, low income, unsafe
neighborhoods, and education. These disparities
disproportionately impact communities of color. As a
result, their health outcomes are worse than others.

We are committing to closing these gaps by:

» Eliminating barriers to health and improving
access to care. Through the Cigna Foundation, we
will continue to make grants to eliminate health
barriers and improve access to care. This includes
needs such as food insecurity and mental health
that we address through our Healthier Kids For
Our Future®” program.*

We are also actively engaged with Congress and
the Administration to address and eliminate racial
and ethnic disparities in health care delivery and
outcomes. For more information, see our 2019
corporate responsibility report.**

» Expanding Cigna's Health Equity Council. Since
2008, our team of multidisciplinary leaders has
been collaborating on research, testing, and
solutions to prevent chronic diseases and improve
health outcomes in minority communities. We
will further accelerate these efforts to address
clinical care, social determinants of health, and
health behaviors.

Improve well-being

Racism and bias take a toll on overall well-being.
Everyone should feel safe in their environment, and
no one should feel the need to confront racism and
bias alone. Our actions therefore include:

» Standing together. We have invited our 75,000+
employees to sign a commitment to embody
inclusive behavior in their professional and
personal lives. We have enabled them to
collectively donate 100,000 hours of volunteer
time each year for programs related to social
justice, health equity, diversity, inclusion, and
community outreach.

* Cigna.com > About Us > Corporate Responsibility > Healthier Kids For Our Future program.

** (igna.com > About Us > Corporate Responsibility > Corporate Responsibility Report.

*** (igna.com > About Us > Corporate Responsibility > Corporate Responsibility Report > Our People > Diversity and Inclusion.
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» Creating inclusive environments. \We now require » Promoting equity and equality in career
unconscious bias training for all employees, and advancement. We are committed to
cultural competency training for all managers. compensating our employees equitably and
We will continue to advance conversations about competitively, regardless of race, gender, age, or
systemic racism in America. sexual orientation, and increasing diversity among

i I hip.
Improve peace of mind our leadership

» Supporting minority businesses. \We are on
track to achieve $1 billion in diverse supplier
funding by 2025.

Financial health is a key element of peace of mind.
Recognizing that racism has a negative economic
impact on people of color, we are:

» Creating more educational opportunities. \We are Governance

partnering with Howard University’s Urban
Superintendent Academy to provide funding for
people of color to become urban public school
superintendents. (See “Cigna supports pipeline of
superintendents of color” on page 36 for more
information.) We are also furthering Cigna
Scholars, a program that assists dependents and
grandchildren of Cigna employees who plan to
pursue post-secondary or vocational education.

Accountability is a key foundation of our overall
equity and equality initiative. We are establishing a
governance process to oversee its elements, while
tracking and reporting on progress.

For more information on Cigna's diversity and
inclusion strategy, click here.***
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POLICY UPDATES

PREVENTIVE CARE SERVICES
POLICY UPDATES

On June 1, 2020 and August 1, 2020, updates became effective for Cigna’s Preventive Care Services
Administrative Policy AOO4.

Summary: Preventive care updates effective on June 1, 2020

DESCRIPTION UPDATE CODES

Women'’s contraception Added ICD-10* code to Code Group 4 Z30.013
services contraceptives-injection

Summary: Preventive care updates effective on August 1, 2020

DESCRIPTION UPDATE CODES

Routine immunizations Added Current Procedural Terminology 90619, 90694
(CPT®) codes

For additional guidance on preventive care services, refer to the Preventive Care Services Administrative
Policy (A0O0O4) on the Cigna for Health Care Professionals website (CignaforHCP.com) > Review coverage
policies > Medical and Administrative A-Z Index > Preventive Care Services - (A004).

* International Classification of Diseases, 10th revision.

4 CIGNA NETWORK NEWS + FOURTH QUARTER 2020



https://cignaforhcp.cigna.com/app/login
https://cignaforhcp.cigna.com/public/content/pdf/coveragePolicies/medical/AD_A004_administrativepolicy_Preventive_Care_Services.pdf

POLICY UPDATES

CLINICAL, REIMBURSEMENT, AND
ADMINISTRATIVE POLICY UPDATES

To support access to quality, cost-effective care for your patients with a medical plan administered by Cigna, we routinely review clinical, reimbursement, and administrative policies for potential updates. As a reminder,
reimbursement and modifier policies apply to all claims, including those for your patients with GWH-Cigna or “G” ID cards.

Planned medical policy updates*

POLICY NAME DESCRIPTION OF SERVICE UPDATE EFFECTIVE DATE

Minimally Invasive Spine Trigger point injection therapy involves the injection of an anesthetic or We will deny coverage for more than 10 trigger point injections in a rolling November 15, 2020 for dates of
Surgery Procedures and steroid into a painful area of muscle. It is used for short-term treatment of 12-month period as not medically necessary. service on or after this date.
Trigger Point Injections chronic back, neck, or myofascial pain. This update aligns with our current Minimally Invasive Spine Surgery
(0139) Procedures and Trigger Point Injections (0139) medical coverage policy.
Omnibus Reimbursement Pulse oximetry is a quick, painless noninvasive test. A sensor is placed on We will deny separate reimbursement for pulse oximetry services when billed November 15, 2020 for claims
(R24) the earlobe, toe, or finger to measure oxygen level or oxygen saturation alone or with additional codes. processed on or after this date.
in the _b|_OOd' It is & routine service that can be performed by clinical or The affected Current Procedural Terminology (CPT®) codes 94760, 94761, and
non-clinical staff. 94762 are considered incidental to the primary service(s) provided. A modifier
will not override the denial. This update will not affect claims with Place of
Service 12 (Home).
Duplex Scan to Evaluate A duplex scan, or ultrasound, is a noninvasive evaluation of blood flow We will deny coverage for CPT code 93882 for unilateral duplex scans when November 16, 2020 for dates of
for Carotid Artery Stenosis  through the arteries and veins. It provides information to a vascular surgeon medical necessity criteria are not met. service on or after this date.
(0542) to make a sound diagnosis and outline a treatment plan. It is a scan done on

one side of the neck rather than on both sides (bilateral).

Continued on next page

* Please note that the planned updates are subject to change. For the most up-to-date information, please visit CignaforHCP.com.
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https://static.cigna.com/assets/chcp/pdf/coveragePolicies/medical/mm_0139_coveragepositioncriteria_invasive_treatment_for_back_pain.pdf
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POLICY UPDATES

Clinical, reimbursement, and administrative
pO“Cy UpdateS continued

POLICY NAME DESCRIPTION OF SERVICE UPDATE EFFECTIVE DATE

Nutritional Support (0136)  Nutritional support can involve oral, enteral, or parenteral nutritional We will update our systems to ensure that claims submitted for nutritional February 15, 2021 for dates of
supplements, and may be necessary for some individuals to maintain support services will be administered consistently across all Cigna claim service on or after this date.
adeqguate nutrition. platforms.

This update aligns with our current Nutritional Support (0136) medical
coverage policy.

Additional information

Coverage policies

To view our coverage policies, including an outline of monthly coverage policy changes and a

full listing of medical coverage policies, visit the Cigna for Health Care Professionals website
(CignaforHCP.com) > Review Coverage Policies.

Modifier and reimbursement policies

To view our reimbursement policies, log in to CignaforHCP.com. Go to Resources > Reimbursement
and Payment Policies > Modifier and Reimbursement Policies. If you are not registered for the
website, go to CignaforHCP.com and click Register. If you do not have Internet access, and would
like additional information, please call Cigna Customer Service at 800.88Cigna (882.4462).
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POLICY UPDATES

PRECERTIFICATION UPDATES

To help ensure that we are administering benefits properly, we routinely review our precertification policies

for potential updates. As a result of a recent review, we want to make you aware that we have updated our
precertification list.

Codes added to the precertification list in Codes removed from the precertification list
October 2020 in October 2020

On October 1, 2020, we added seven new Current On September 11, 2020, we removed 52 existing
Procedural Terminology (CPT®) codes and 19 new CPT codes and three existing HCPCS codes
Healthcare Common Procedure Coding System from the precertification list that no longer
(HCPCS) codes. require precertification.

To view an outline of these monthly precertification updates, as well as the complete list of services
that require precertification of coverage, log in to the Cigna for Health Care Professionals website
(CignaforHCP.com) > Resources > Clinical Reimbursement Policies and Payment Policies >
Precertification Policies. If you are not registered for the website, go to CignaforHCP.com and click
Register. If you do not have Internet access, and would like additional information, please call Cigna
Customer Service at 800.88Cigna (882.4462).
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ELECTRONIC TOOLS

HOW TO REQUEST FEE
SCHEDULES ONLINE

REGISTER TO RECEIVE INSTAMED
PATIENT PAYMENTS

Your patients with Cigna-administered plans can now choose to pay you for their out-of-pocket expenses
through myCigna.com, our customer website. We recently integrated the health care bill payment capabilities
of InstaMed, a J.P. Morgan company, with myCigna.com to implement this enhanced service. Please note: This
does not affect payments you receive directly from Cigna.

How you receive patient payments

If you are registered for an InstaMed Healthcare
Payments Account, you will receive the payments
via electronic funds transfer (EFT) directly into

your bank account. Otherwise, you will receive the
payments via a virtual card, which allows you to
deposit the payment directly into your bank account
using your on-site point-of-sale device.

Benefits to you

When your patients pay you via myCigna.com,
you can:

» Receive quicker payments.
» Access detailed reporting.

» Reduce administrative time and costs - no need
to mail a bill or make a phone call.

How it works

As soon we process and pay your claim, we calculate
the patient responsibility. Your patient can see

this information after logging in to their customer
account on myCigna.com, where there is also an
option to pay what they owe you. When your patient
chooses this option, you'll either receive the payment
via your InstaMed Healthcare Payments Account or a
virtual card.

How to register with InstaMed

If you haven’t already registered for an InstaMed
Healthcare Payments Account, visit InstaMed.com/
go-electronic or call InstaMed at 866.945.7990.

8 CIGNA NETWORK NEWS + FOURTH QUARTER 2020

It's easy to request fee schedules when you're

a registered user of the Cigna for Health Care
Professionals website (CignaforHCP.com) and
have access to one of the following entitlements:
Claim Status Inquiry or Enroll and Manage EFT.

You can reqguest fee schedules for:
» Up to 25 individual codes.

» A range of codes, by specialty, that you
can narrow to a specific type of service, such
as evaluation and management, pathology,
or radiology.

One common reason providers use this tool is to
access quarterly injectable fee changes.

To access your fee schedule, log in to
CignaforHCP.com > Working with Cigna >
Reqguest a fee schedule. You will receive the
requested fee schedule information to your
secure inbox located on CignaforHCP.com within
10 calendar days.

Ol E EEEEEEEEHS
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ELECTRONIC TOOLS

VIEW YOUR PATIENTS' BENEFITS
BY PROCEDURE CODE

We've heard your feedback and are working hard to make it easier for you to verify your patients’ benefits.
We have started to roll out a new feature on the Cigna for Health Care Professionals website
(CignaforHCP.com) that enables providers to view their patient’s benefit information for certain

procedure codes.

How it works

Log in to CignaforHCP.com and perform a patient
search. After locating your patient from the Patient
Detail Screen, click Lookup Procedure Codes. Then,
enter the procedure code or search by description.
You may be prompted to include the diagnosis code
and/or the place of service. You may enter up to

10 procedure codes in a search. Click See Benefit
Preview, and the benefit information for those
specific codes will display for that patient.

A phased-in approach

We are in the process of rolling out this feature to a
small number of medical providers rendering the
types of care listed below.

» Anesthesia

Audiology

Chiropractic care

Occupational, physical, and speech therapies
Physician visits

Preoperative lab work

v Y v

Surgical

As part of this enhanced feature, you will have a
refreshed view that allows you to quickly determine
if patients have met their deductible and out-of-
pocket costs, or have any plan limitations.

Coming soon

We will continue to expand this feature, in phases, to
additional provider types after we evaluate and vet
its performance for the initial user groups. We will
notify you via email and future Network News
articles when you will have access to this feature.

9 CIGNA NETWORK NEWS <+ FOURTH QUARTER 2020
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ELECTRONIC TOOLS

ONLINE CLAIM
RECONSIDERATION REQUESTS

The ability to submit claim reconsideration requests via the Cigna for Health Care Professionals welbsite
(CignaforHCP.com) is coming soon. This is an enhancement you've been asking for and we've been

working hard to provide you with an easy-to-use tool.

Why online claim reconsideration?

» Avoid having to call Customer Service for simple
claim adjustments.

» Save time - no need to mail or fax.
» Use the notes section to explain your request.

» Use the upload feature to attach supporting
documentation.

» Be confident your request was received.

» View the status of the reconsideration request.

10 CIGNA NETWORK NEWS -

How to use the new feature

Log in to CignaforHCP.com. Conduct a claim search
and select the claim to review the details. Click “Start
a Reconsideration” at the top of the page and follow
the steps.

To use this feature, you need to be a registered user
of CignaforHCP.com, have the ability to view claims,
and have access to “reconsiderations.” Ask your
practice’s website access manager for these
entitlements if you need them.

To register for the website, go to CignaforHCP.com >
Register.

Be on the lookout for an email announcing
the new online capability.

FOURTH QUARTER 2020

ONLINE CLAIM APPEALS
COMING SOON

We are enhancing the claim reconsideration feature on the Cigna for Health Care Professionals welsite
(CignaforHCP.com) to include the ability for you to submit claim appeals, appeal precertification decisions,
and check the status of your appeal online.

Why submit appeals online?
» Save time - no need to mail or fax the appeal.

» Use the notes section to explain your request, or upload your written request and attach
supporting documentation.

» Be confident your request was received.
» Avoid having to call Customer Service to check the status of your appeal.

To use this feature, you will need to be a registered user of CignaforHCP.com and have the appropriate
access. Watch for updates on when this enhanced functionality will become available.

Ol E EEEEEEEEHS
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ELECTRONIC TOOLS

WEBINAR SCHEDULE FOR

DIGITAL SOLUTIONS

You’re invited to join interactive, web-based demonstrations of the Cigna
for Health Care Professionals website (CignaforHCP.com). Learn how to
navigate the site and perform time-saving transactions such as eligibility
and benefit inquiries, claim status inquiries, electronic funds transfer (EFT)
enrollment, and more. There is also a special training session for website
access managers. The tools and information you'll learn about will benefit
you and your patients with Cigna coverage.

Preregistration is required for each webinar

(Please take note of the time zones for each session.)

1. On the chart to the right, click the date of the webinar you'd like
to attend.

2. Enter the requested information and click Register.

3. You'll receive a confirmation email with the meeting details, and links
to join the webinar session and to add the meeting to your calendar.

Three ways to join the audio portion of the webinar:

Option 1 - When you link to the webinar, “Call me” will appear in a
window. If you have a direct outside phone line, you can click this option.
You'll receive a phone call linking you to the audio portion.

Option 2 - Call 866.205.5379. \WWhen prompted, enter the corresponding
Meeting Number shown on the right. When asked to enter an attendee ID,
press #.

Option 3 - Call in using your computer.

Questions?
Email: ProviderDigitalSolutions@Cigna.com
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TOPIC

CignaforHCP.com Overview

Eligibility & Benefits/Cigna Cost of
Care Estimator

EFT Enrollment, Online Remittance,

and Claim Status Inquiry

Online Claim Reconsideration

Website Access Manager Training

CignaforHCP.com Overview

Eligibility & Benefits/Cigna Cost of
Care Estimator

EFT Enrollment, Online Remittance,

and Claim Status Inquiry

Online Claim Reconsideration

Website Access Manager Training

Wednesday, November 4, 2020

Wednesday, November 11, 2020

Wednesday, November 18, 2020

Thursday, November 19, 2020

Tuesday, November 24, 2020

Tuesday, December 1, 2020

Thursday, December 10, 2020

Wednesday, December 16, 2020

Thursday, December 17, 2020

Wednesday, December 30, 2020
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TIME (ET/CT/MT/PT)

12:30 PM/11:30 AM/10:30 AM/9:30 AM

11:00 AM/10:00 AM/9:00 AM/8:00 AM

12:30 PM/11:30 AM/10:30 AM/9:30 AM

12:30 PM/11:30 AM/10:30 AM/9:30 AM

10:00 AM/9:00 AM/8:00 AM/7:00 AM

12:30 PM/11:30 AM/10:30 AM/9:30 AM

1:00 PM/12:00 PM/11:00 AM/10:00 AM

10:30 AM/9:30 AM/8:30 AM/7:30 AM

1:00 PM/12:00 PM/11:00 AM/10:00 AM

12:00 PM/11:00 AM/10:00 AM/9:00 AM

LENGTH

90 min

60 min

60 min

60 min

60 min

90 min

60 min

60 min

60 min

60 min

MEETING
NUMBER

129176 2226

129 470 1698

129 897 2151

129 319 7768

129 297 9714

129 304 2510

129 666 2102

129 682 5433

129 859 8290

129 305 4715
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CONNECTED CARE

STAYING CONNECTED WITH
YOUR PATIENTS THROUGH

VIRTUAL CARE

As your patients seek more convenient and safe options to obtain health care, they have expressed a growing
interest in virtual care (i.e., telehealth). This is an option that can give them greater access to and connection

with their provider.

Virtual Care Reimbursement Policy (R31)
effective January 1

To help providers attract and retain patients, reduce
access barriers, and contribute to their ability to
provide the right care at the right time, we will
implement a new Virtual Care Reimbursement
Policy on January 1, 2021.*

This policy will ensure you continue receiving
ongoing reimbursement for virtual care provided
to your patients with Cigna-administered coverage.

Virtual services reimbursed

Our policy allows for reimbursement of a variety of
services typically performed in an office setting, but
that are also appropriate to perform virtually. They
include routine appointments, general wellness visits,
new patient exams, and behavioral assessments.
Whether you’re seeing a new patient or performing
a routine check-up with an established patient to
renew a prescription, you can receive reimbursement
for your patients with Cigna coverage.

Common codes included in our policy

(e{o]n] 3

99202-99215
97161-97168

DESCRIPTION

Outpatient

Physical and
occupational therapy

99441-99443
G0438-G0439

Telephone only

Annual wellness visit

For a complete list of covered services, please refer
to the Virtual Care Reimbursement Policy (R31) by
visiting CignaforHCP.com/virtualcare.

Billing and reimbursement requirements

For services included in our Virtual Care
Reimbursement Policy (R31), a number of general
requirements must be met for Cigna to consider
reimbursement for a virtual care visit. When all
requirements are met, services will be reimbursed
consistent with face-to-face rates to help ensure
providers continue receiving fair reimbursement.**

*Please note that our interim COVID-19 virtual care guidelines remain in place until December 31, 2020. If it is necessary to extend the interim coverage without change based on an
extended public health emergency period, our new Virtual Care Reimbursement Policy may be implemented at a later date, and we will update you as needed. We are committed to

ensuring continued access to virtual care for you and your patients with Cigna coverage.

** State and federal mandates, as well as customer benefit plan design, may supersede this quidance.
*** Al synchronous technology used must be secure and meet or exceed federal and state privacy requirements.
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Billing requirements

>

Be sure services are on the list of eligible codes in
our Virtual Care Reimbursement Policy (R31).
Submit claims on Form CMS-1500 or the
electronic equivalent.

Append modifier 95, GT, or GQ to the virtual

care code(s).

Bill a typical place of service (e.g.,, POS 1) to
receive the same reimbursement as for a face-to-
face visit. Billing POS 02 for virtual services may
result in reduced payment or denied claims.

Be sure that services are interactive, and use both
audio and video Internet-based technologies (i.e.,
synchronous communication), except for the
noted phone-only codes.***

BILLING EXAMPLE

Service performed

Current Procedural Terminology (CPT®) code billed

Modifier appended to billed code

Place of service billed

Technology used

Reimbursement received (if covered)

Customer cost share

QAN EEEEEEEEHS

» Do not submit claims for “store and forward
communications” (e.g., email or fax
communications), as they are not reimbursable.

For a complete list of the billing requirements,
review the Virtual Care Reimbursement Policy (R31)
at CignaforHCP.com/virtualcare.

Additional information

Please visit CignaforHCP.com/virtualcare, contact
your provider representative, or call Cigna Customer
Service at 800.88Cigna (800.882.6642).

Office or other outpatient visit for the evaluation
and management of a new patient.

99202

95, GT, or GQ

1

Audio and video

100 percent of face-to-face rate

Applies consistent with face-to-face visit



https://static.cigna.com/assets/chcp/resourceLibrary/medicalResourcesList/medicalDoingBusinessWithCigna/medicalDbwCVirtualCare.html
https://static.cigna.com/assets/chcp/resourceLibrary/medicalResourcesList/medicalDoingBusinessWithCigna/medicalDbwCVirtualCare.html
https://static.cigna.com/assets/chcp/resourceLibrary/medicalResourcesList/medicalDoingBusinessWithCigna/medicalDbwCVirtualCare.html
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CONNECTED CARE

EMPATHIZING MAY BE KEY TO
IMPROVING YOUR PATIENTS’ HEALTH

This article was written by Douglas Roland Smith, MD, MBA, Market Medical Executive, Cigna. We welcome article submissions from providers. Please email

NetworkNewsEditor@Cigna.com.

In these tense and stressful times, it's more critical
than ever to establish personal connections

with patients. This can help you to identify and
acknowledge unmet social needs, also known as
social determinants

of health. When these

needs are not met, they (11
can negatively impact

your patients’ overall

quality of life, and the

ability to manage their

health and adhere to

treatment plans.

Asking questions can build connections

It may seem daunting to ask patients questions
about their financial burdens, access to food,
transportation needs, feelings of loneliness, and
other social determinants of health.

But, there is good news: Validated, researched-based
questions are already available on the American
Academy of Family Physicians website (AAFP.org) >
Family Physician > Patient Care: EveryONE Project >
EveryONE Project Toolkit > Assessment and Action:
Social Needs Screening Tools > Social Needs
Screening Tool.

Could a greater miracle take place
than for us to look through each
other’s eyes for an instant? LE

What if | ask about a social need and cannot
address it?

This is a valid concern. Again, there is good

news. In most communities, free resources are
available that you can
refer your patients to
quickly and easily.

Go to AAFP.org >
Family Physician >
Patient Care:
EveryONE Project >
Neighborhood
Navigator.

— Henry David Thoreau

Empathy = personal connection =

improved adherence

When you ask, truly listen, and empathize with
patients about their social needs, it will help you

to establish personal connections with them. This
can lead to more transparent patient encounters
and improved adherence to treatment plans. Most
patients don’t expect you to solve their unmet social
needs, but will be thankful you asked, listened, and
validated their experiences.
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Empathy can be learned

Many of us have heard over the years that a
provider’s level of empathy for their patients is
inversely correlated with their years of experience.

In other words, those with more years of experience
tend to be less empathetic. If you feel this applies to
you, take heart in knowing that no matter where you
are on the empathy spectrum, you can learn to be
more empathetic.

Your patients are experiencing life through
a different lens

Try to let go of preconceived biases, which may be
wrong and unhelpful. Instead, really listen and then
be kind. When you empathize and seek to apply
compassion, patients will be more willing to trust
you, be compliant with your guidance, and think
more highly of you after the visit.

EMPATHY: MY
PERSONAL JOURNEY

by Douglas Roland
Smith, MD, MBA, Market

Medical Executive, Cigna

White bows lined the street.

They were tied to any object that would make
their presence prominent and visible. Our hope
was that the bows would, in some way, lighten
our friends’ burden of grief. Their 18-year-old
son had suddenly and unexpectedly died.

Any combination of words we could say felt

so insignificant.

As my wife went door to door asking neighbors’
permission to tie bows to their trees, mailboxes,
and bushes, conversations naturally developed.
Without fail, on learning the purpose of

the bows, many wanted to be part of the
compassionate gesture. One elderly woman
broke down in tears. Her own husband died a
year ago and she lived alone in a city far from
family in Armenia. Her loneliness was poignant.

This experience helped me to realize that people
of all walks of life may gquietly carry hidden
burdens, which may not be apparent unless |
make a personal connection with them. Once

| know their struggles and put myself in their
shoes, it's easier for me to empathize with and
help them.

At times empathy can be hard to muster. When
covering late nights in the emergency room,

| have just a few moments to help the stranger
in front of me. I'm naturally inclined to like some
people, while others seem to search for ways

to be disliked. The only way | know how to do
my best for all of them is to empathize with
each individual’'s situation. This requires true
listening. Compassion then moves me to the
most helpful action.
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CONNECTED CARE

CIGNA RESILIENCE INDEX:
2020 U.S. REPORT

Research shows that resilience is closely linked to mental and physical health, stress, anxiety, self-worth, self-
esteem, sense of belonging, academic and professional achievement, and several other factors that play a role
in whole person health.

Cigna is here to help you take a well-rounded approach to improving emotional wellness - for you and for
your patients.

To further our mission of building healthier communities, we commissioned the Cigna Resilience Index, in
partnership with Michael Ungar, PhD, Professor of Social Work at Dalhousie University and Director of the
Resilience Research Centre. Through this work, Cigna has led the largest study into the state of resilience
in America.

This new survey shows that resilience is at risk for three in five Americans, and reveals a significant connection
between low resilience, productivity in the workplace, and overall health. The survey also shows that building
and practicing resilience from a young age greatly influences overall health and well-being through adulthood.

From these insights, we have created a new framework to help people G.R.O.W. in the face of challenges
and become more resilient.

G‘R{O$Wi

G - Ground yourself in the situation. Write down your ideal outcome.
R - Recognize what you can control. Commit to one thing you can tackle today.
O - Organize the resources you need. Visit CignaResilience.com to access expert resources.

W - Work with your community for support. Remember that asking for help is a sign of strength.

To learn more about the 2020 Cigna Resiliency Index and GROW FORTH: A Cigna Approach to Building
Greater Resilience, please visit CignaResilience.com.

For resources to complement your patient conversations on behavioral health, visit our dedicated Mind-Body
website for providers at Cigna.com/connections.

continued
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RESOURCES YOU'LL FIND AT CIGNARESILIENCE.COM

BUILDING GREATER RESILIENCE IN AMERICA

The Cigna Resilience Index reveals that resilience -
or our ability to quickly recover from challenges -
is at risk in three in five Americans, and finds that
there are simple ways to build resilience.

Learn about the key drivers of resilience

HOW RESILIENT ARE YOU?

This questionnaire from Cigna measures how
resilient you are today and offers advice to
help you and your patients build resilience
for tomorrow.

Take the questionnaire now

HOW TO BUILD RESILIENCE: GROW FORTH

Based on study findings, GROW FORTH. A Cigna
Approach to Building Greater Resilience offers a

new framework to help you and your patients
\r j: G.R.OW. in the face of challenges through four
| simple steps.

Learn how to build your resilience

CIGNA RESILIENCE INDEX: 2020 U.S. REPORT

This in-depth report of the Cigna Resilience Index,
the largest U.S. survey of resilience, examines the
ability of students, their parents and working
adults to recover from challenges.

Learn more about the impacts of low resilience
and ways to build resilience

QAN EEEEEEEEHS
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Cigna Resilience Index: 2020 U.S. Report continved

RESILIENCE IS AT RISK FOR THE MAJORITY OF AMERICANS SURVEYED

60% OF AMERICANS DO NOT PRETEENS THROUGH YOUNG ADULTS AGE 11-23 ARE YOUNG ADULTS WITH LOW RESILIENCE ARE 8X LESS
HAVE HIGH RESILIENCE EXPERIENCING A SHARP DECLINE IN RESILIENCE LIKELY TO FEEL THEY HAVE OPPORTUNITIES TO
APPLY THEIR ABILITIES IN LIFE

TODAY, AMERICANS ARE NATURALLY FEELING THE IMPACT OF MAJOR STRESSORS SUCH AS COVID-19, THE ECONOMIC DOWNTURN, INCREASED DIVISIVENESS, AND AWARENESS OF
SYSTEMIC RACISM.

3 M s

CHILDREN (AGE 5-17) YOUNG ADULTS (AGE 18-23) PARENTS
54* 65" 74"
More than half of children Two in three young adults are feeling more stressed and anxious Nearly three in four parents are feeling stressed and anxious
feel distressed or anxious due to COVID-19.* about the recent deaths of Black Americans than about the due to COVID-19, and more than six in 10 (62%) are stressed by
current economic uncertainty. the current economic uncertainty.

* Parent-reported statistic.
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CONNECTED CARE

EDUCATING YOUR PATIENTS
ABOUT GUN SAFETY

You play a central role in helping to educate families about some of the added dangers they may face as
children continue to stay close to home during the pandemic. For some conversations - such as those
between a pediatrician and a parent - proper gun storage and safety tips may be appropriate and timely.

Cigna is proud to support the American Academy of Pediatrics (AAP) campaign to promote gun safety in
the home. This campaign encourages conversations among parents, as well as between providers and their
patients, about properly securing guns to help prevent injury.

To help support provider-parent conversations, the AAP has released a number of tips, such as those
listed below.

» Store the gun unloaded and locked, with the ammunition securely locked in a separate place. This can
greatly reduce the risk of a child being injured or killed by the gun.

» Choose a gun storage system that fits the home. A wide variety of gun safes and gun safety devices are
available, including inexpensive gun locks, trigger locks, and lock boxes.

» Before bringing children into the home, such as a new baby or children coming for a short stay, include
safe gun storage as part of the home safety sweep. In addition to putting away medicines and poisons,
covering outlets, and stabilizing furniture, parents should lock up firearms.

For additional information about the AAP’s campaign to promote gun safety, and more tips, videos, public
service announcements, infographics, and materials to support your patient education efforts, visit the AAP
website (AAP.org) > About the AAP: News Room > Campaigns & Toolkits > Gun Safety.

DID YOU KNOW?
A recent study published by the AAP found that parents erroneously believed their child:

» Did not know where their gun was stored (39 percent)

» Never handled a gun (22 percent)
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https://services.aap.org/en/news-room/news-releases/aap/2020/unsecured-guns-a-danger-to-children-during-covid-19-outbreak/
https://www.aap.org/en-us/Pages/Default.aspx
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NETWORK UPDATES

CIGNA GENE THERAPY PROGRAM

Important medical advances in gene therapy are being introduced for the treatment of genetic disorders and
acquired diseases. The U.S. Food and Drug Administration is expected to approve more than 20 gene and cell

therapies in the next three to four years.

To manage quality and affordability of these emerging therapies, we introduced the Cigna Gene Therapy
Program earlier this year. The program directs customers to qualified participating providers.*

Gene therapy coverage

A customer’s benefit plan will govern coverage of
gene therapy products and administrative services.
There are specific providers within the Cigna
network who are contracted to administer gene
therapy treatments to customers with this benefit
when medically necessary.

Providers in the program

We are pleased to announce the additional providers
listed below have contracted to participate in the
Cigna Gene Therapy Program.

Florida UF Health Shands Hospital, Gainesville

New York Children’s Hospital at Montefiore,
Bronx

Ohio Children’s Hospital Medical Center

of Akron, Akron, and
Cincinnati Children’s Hospital
Medical Center, Cincinnati

Pennsylvania Scheie Eye Institute Penn
Presbyterian, Philadelphia

To access the complete list of participating
providers,* log in to the Cigna for Health Care
Professionals website (CignaforHCP.com) >
Resources > Reimbursement and Payment Policies
> Precertification Policies > Cigna Gene Therapy
Program for Participating Providers.

Additional information

The Cigna Reference Guide for physicians, hospitals,

ancillaries, and other health care providers includes
additional information on gene therapy and the
Cigna Gene Therapy Program. To access this
guide, log in to CignaforHCP.com > Resources

> Reference Guides > Medical Reference Guides:
View Documents > Health Care Professional
Reference Guides.

If you have questions about the Cigna
Gene Therapy Program, contact your Cigna
Contracting representative.

* Participating provider refers to providers who have amended their contracts to participate in the Cigna Gene Therapy Program.
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CLINICAL NEWS

CIGNA’S FLU SHOT CAMPAIGN

In a health care delivery system already strained by the COVID-19 pandemic, many in the medical
community are concerned about the potential for a flu pandemic during this flu season. Like you, we
share this concern. That’s why we are supporting your expert medical advice by promoting widespread
flu vaccinations to our customers.

About the campaign

Earlier this month, we launched a multipronged educational campaign reminding customers about the
importance of getting a flu shot this year, as well as when, where, and how to obtain it. Our materials highlight
how getting vaccinated protects them, their families, and their community from a major flu outbreak, and
dispels myths and fears about the shots.

The campaign includes:

» An email encouraging immunization for anyone age six months and older, emphasizing the benefit of
preventing or reducing the severity or symptoms of the flu.

» A reminder email in early December to those who haven’'t obtained a flu shot yet, advising them that it’s
not too late to get one.

» A social media campaign, ongoing messaging on myCigna.com, and vaccination reminders enclosed with
home delivery maintenance medications.

» A flu shot toolkit for employer groups that contains customizable education materials they can use to
encourage employees and their families to get vaccinated.

Additional outreach

We will continue to monitor vaccination rates throughout the season, and make additional outreaches to
higher-risk individuals and underserved populations, as needed, to encourage them to get flu shots.
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QUALCARE NEWS % QUALCARE

A Cigna Company

COVID-19 RESOURCES

We appreciate that providers are on the front line
helping to protect local communities and offering
dedicated care to our customers affected by the
coronavirus disease 2019 (COVID-19) pandemic.

For quick access to COVID-19 resources, including
interim billing guidance for Qual-Lynx workers’
compensation virtual care, visit the QualCare
website (QualCarelnc.com). We encourage you
to check this welbsite regularly to keep up to date
with changing information.
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WORKERS’ COMPENSATION, HMO,
AND PPO PLANS IN FOCUS

QualCare remains focused on workers’
compensation, health maintenance organization
(HMO), and preferred provider organization
(PPO) plans.

Our workers’ compensation footprint in New
Jersey is growing as we continue to add new
employer groups that seek high-quality, cost-
effective medical treatment, as well as efficient

claims handling, to meet their employees’ workers’

compensation needs.

Qual-Lynx is a certified workers’ compensation
managed care organization that provides a full
suite of managed care and third-party claims
administration services to payers, public entities,
stand-alone municipalities, and other self-insured
entities. Its professional team of nurse case
managers and claims adjusters direct customers

who need medical treatment under workers’
compensation plans to QualCare provider partners.

Our HMO and PPO networks will continue to be
active for your patients who access them through
Oscar, Humana, and EmblemHealth. They serve
numerous employer groups in the New Jersey area,
including several large ones.

If you have guestions about the QualCare provider
network, please call QualCare Provider Services
at 800.992.6613.

ASO PLAN REMINDER

Effective for dates of service January 1, 2020
and beyond, QualCare is no longer offering
administrative services only (ASO) plans.
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QUALCARE NEWS

A Cigna Company

CHANGE HEALTHCARE BILLING AND
CLAIMS PROCESSING REQUIREMENT

As a reminder, QualCare network-participating providers in New Jersey who submit more than 24 workers’

compensation claims per calendar month must submit them electronically through Change Healthcare
using payer ID 83867. This requirement has been in place since November 2019.

To expedite processing and payment of your claims, use either the:

» Claim number listed on the Qual-Lynx Duty Determination Form, or

» Authorization number given by the claim adjuster or nurse case manager when scheduling the patient’s
initial visit.

You must also submit medical notes within 48 hours of the visit.
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%QUALCARE“’

PHARMACY NEWS

CHANGES IN DRUG FORMULARY
EFFECTIVE JANUARY 1, 20271*

Effective January 1, 2021, we will make changes
to our commercial, Individual & Family Plan, and
Cigna Total Savings drug formularies to help
ensure our customers have access to affordable
and quality health care. These updates focus

on removing egregiously priced drugs, and
promoting generic and over-the-counter drugs as
well as therapeutic alternatives.

What this means to you and your patients
with Cignha coverage

In September 2020, we sent letters explaining

the drug list changes to affected providers and
customers. Your patients with Cigna-administered
coverage may contact you directly to discuss
medication alternatives, which in many cases are
available at a lower out-of-pocket cost to them.
By making these updates, we have the
opportunity to:

Beginning January 1, 2021, customers who
continue filling prescriptions for drugs that are no
longer on the formulary may experience higher
out-of-pocket costs. We encourage you to work
with your patients who have Cigna Pharmacy
coverage to find covered, clinically appropriate
alternative medications before this date.

» Lower overall claim costs.
» Improve medication adherence.

» Promote viable alternatives through a utilization
management strategy.

Additional information

To obtain a list of the affected drugs, or to search for alternative medications for your patients, please
refer to the resources listed below.

RESOURCE DESCRIPTION WHERE TO FIND

Prescription Drug List
changes for 2021

The list highlights the covered
preferred, brand-name, and
generic medications within the
affected drug classes. These
changes only apply to Cigna's
non-Medicare customers.

Go to CignaforHCP.com > Get gquestions
answered: Resource > Pharmacy
Resources > Cigna’s Prescription Drug
Lists: View Documents.

Customer-specific drug This tool allows you to search

coverage search tool specific drug lists for patients
with Cigna-administered
coverage, and view their
estimated out-of-pocket costs
based on their benefit plan.

Log in to CignaforHCP.com. Then,
perform a patient search by name, ID
number, or date of birth. You must be
a registered user of the website to use
this tool.

* For Texas- and Louisiana-insured customers, the effective date may be deferred until the plan renew date, as required by state law.
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PHARMACY NEWS

MEDICAL ONCOLOGY CLINICAL
DECISION SUPPORT ENHANCEMENT

In September 2020, eviCore healthcare (eviCore),
a Cigna company, enhanced its ability to assist
oncology providers in choosing the best evidence-
based treatment regimen for their patients with
Cigna-administered coverage. eviCore provides
utilization management services for medical
oncology prior authorization requests for

Cigna customers.

How the enhancement helps providers

For each treatment regimen, eviCore’s clinical
decision support information now displays febrile
neutropenia risk and emetic risk. Oncology
providers can view this information during

the prior authorization process on the eviCore
website (eviCore.com).

11

The addition of these data points will

assist busy oncologists in choosing the
optimal treatment regimen for their patients.
We are committed to improving the value

of our Clinical Decision Support solution

and this step is the latest example in a

series of upcoming enhancements. LE

— Dr. Stephen Hamilton
Chief of Medical Oncology
eviCore healthcare

Additional enhancements coming soon

In the coming months, we will share information
about additional enhancements eviCore is making
to enrich providers’ experience with its medical
oncology solution.
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ONCOLOGY CLINICAL PATHWAY

PROGRAM

On January 1, 2021, Cigna will launch an oncology
clinical pathway program to promote the use of
clinically appropriate, safe, and cost-effective
therapies to improve patient outcomes.

This program is intended to improve quality and
value in cancer care by providing treating
oncologists with evidence-based data to assist
them in selecting chemotherapy regimens that
represent the highest value for their patients with
Cigna-administered coverage.

Its regimens are selected based on clinical
efficacy, safety, quality, and consistency of
evidence, as well as affordability, if appropriate.
The program will use a value assessment model
that incorporates value frameworks established by
the American Society of Clinical Oncology,
National Comprehensive Cancer Network®
(NCCN), and European Society for Medical
Oncology to help ensure pathway regimens reflect
the highest value cancer therapies. The use of
multiple value frameworks has the potential to
improve the patient’s quality of life, reduce out-of-
pocket costs, and optimize treatment outcomes.

How the program will work

The oncology clinical pathway program will be
available for specific cancer types and stages, and
will be updated based on new clinical evidence,
new U.S. Food and Drug Administration (FDA)
approvals, or expanded FDA indications.

The oncology clinical pathway regimens will be
highlighted during the prior authorization process
on the eviCore healthcare (eviCore) website
(eviCore.com). Providers who request one of
Cigna’s pathway program regimens will receive
immediate approval of the treatment plan.

If a provider requests a regimen that isn’t part of
Cigna’s pathway program, a prompt will appear and
the provider will have the opportunity to select a
pathway program regimen. If the provider proceeds
with a nonpathway regimen, he or she can provide
supporting clinical information. An eviCore medical
oncologist may contact the provider to discuss the
patient’s condition and potential benefits of a high-
value pathway regimen, if applicable. However, any
regimen approved by the FDA or given a category 1,
2A, or 2B recommendation by the NCCN Clinical
Practice Guidelines in Oncology will be authorized
in accordance with our Oncology Medications
coverage policy.

The oncology clinical pathway program will not apply
to all clinical scenarios and is not a substitute for the
experience and judgment of the treating provider.
The treatment decision remains the responsibility of
the treating oncologist.

View the coverage policy

You can access the Oncology Medications policy
by going to the Cigna for Health Care Professionals
website (CignaforHCP.com) > Review coverage
policies: information on Cigna standard health
coverage plan provisions > Pharmacy (Drugs &
Biologics) A-Z Index: View Documents > Oncology
Medications - (1403).

Additional information

For more information about this program, please
contact your Medical Market Executive.
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PHARMACY NEWS

ACCREDO’S DIGITAL TOOLS
HELP YOUR PATIENTS MANAGE
MEDICATIONS

Accredo, a Cigna specialty pharmacy, provides your patients with simple, convenient digital tools and easy
access to personalized clinical support. Accredo’s goal is to help patients manage their medications how and
when they want.

Accredo.com and Accredo app Did you know?

The Accredo website (Accredo.com) and the mobile » Patients who use digital tools have 12-point higher

app were designed with your patients in mind. They satisfaction scores than those who do not use

offer the ability to: them’

» View order status and history. » Patients who use Accredo.com and the mobile

» Refill medications. app are six percent more adherent than those
who do not use them:®

» Make payments.

» Create dose reminders (mobile app).

Research condition-specific information (website). €E
All of our digital enhancements are

patient focused and designed to make
it easy for them to interact with our
high-touch care model - whenever

Your patients may also enroll in Accredo’s texting
programs to receive refill reminders, receive order
and shipment notifications, and order refills.! They
can enroll at Accredo.com or when speaking to an

. and wherever they need. LE
Accredo representative.
— Pechal WHAT PATIENTS HAVE TO SAY ABOUT THE ACCREDO APP*
Specialty-Trained Pharmacist EE This app makes it easy to order refills and | really like the reminder feature. | have missed
Accredo doses in the past, but with this feature | received a text to remind me to take my meds and
have not missed any more doses. LY
— Accredo app user
£c Ordering through the Accredo app is fast, easy, and | can do it at any time of the day or
night! It’s accurate and my supplies comes in time for my next dosing. Thank you Accredo! J)
1. Some specialty medications are not eligible for online or text refills. — Accredo app user

2. Accredo Net Promoter Score data, December 2019.
3. Accredo book-of-business data for subset of patients taking medication for rheumatoid arthritis or other inflammatory conditions, 2019.
4. Testimonials from the App Store.
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PHARMACY NEWS

TRANSITION TO EXPRESS SCRIPTS
PHARMACY: REMINDER

When your patients with Cigna-administered coverage transition to Express Scripts Pharmacy, a Cigna
company, the home delivery prescription fulfillment and prior authorization process will change.

What this means for you
Electronic prior authorization (ePA)

For your patients who have transitioned to Express Scripts Pharmacy, you can request prior authorization
through your electronic health record (EHR) or electronic medical record (EMR) system, or through one of
the ePA vendors listed below.

EHR/EMR
EPA VENDOR AVAILABILITY WEBSITE AVAILABILITY QUESTIONS

CoverMyMeds” Yes, go to Call CoverMyMeds at
CoverMyMeds.com/ePA/Cigna. 866.452.5017.
Surescripts® Yes No Call Surescripts at
866.797.3239.

Communications

For these patients, you may receive communications that include the Express Scripts name. You may also
notice a change in the way you receive such communications. For example, messages will be sent to you via
your EMR, or by letter or fax.

For now, please continue to send prescriptions to Cigna Home Delivery Pharmacy, unless a patient specifically
asks that you send them to Express Scripts Pharmacy. We will notify you when you can begin sending all
home delivery prescriptions to Express Scripts Pharmacy.

What this means for your patients

Patients who have transitioned to Express Scripts Pharmacy will see the Express Scripts name on bottles,
packaging, and related correspondence. They may also notice a change in the shape, size, and/or color of
their medication.

Questions?

If you have any gquestions about this transition, please call Cigna Customer Service at 800.88Cigna (882.4462).
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MEDICARE NEWS

2021 CIGNA MEDICARE
PLAN HIGHLIGHTS

New benefits to meet patient needs

2021 will bring new benefits and services for Cigna Medicare patients, with more comprehensive coverage,
affordable and predictable out-of-pocket costs, and extended health benefits - to help your patients access
the care they need, when they need it.

More flexibility and stability to get patients healthier

94%

will have a $0 primary care
provider (PCP) copayment

96%

will have a flat or
reduced premium

Nearly 100%

will have fitness, dental, eyewear,
meal, and hearing aid benefits

73%

will have
a $0 premium plan

85%

will have an
over-the-counter benefit

75%

will have access to a
transportation benefit

New 2021 benefits for all Cigna Medicare patients

» $0 behavioral health
Patients have access to affordable behavioral specialty and psychiatric care at a $0 copayment, eliminating
financial barriers for individual and Employer Group Waiver Plan patients.

» No-cost 24/7 online wellness resources
This includes general wellness and prevention, disease management, fitness and exercise, men’s and
women’s health, smoking cessation, weight management, advanced care planning, senior health, and more.

» Telehealth for physical therapy (PT)
This benefit is in addition to our behavioral health and primary care telehealth services. Any participating
PT provider who offers telehealth can use it; cost share is the same as in-person PT.
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Reaching more communities

In 2021, Cigna will offer plans in 369 counties spanning 23 states, representing a 22 percent increase in our
county footprint. We will expand to 67 new counties, and include a broad portfolio of health maintenance
organization (HMO) and preferred provider organization (PPO) plans. In addition to the new county
expansion, we will expand PPO offerings in 154 counties in our existing footprint. PPO plans typically offer
an out-of-network benefit, while HMO plans generally do not.

Cigna will enter markets in five new states in 2021 with Medicare plans:
New Mexico (Albuquerque area)

Ohio (Liberty Valley/Cleveland)

Oklahoma (Oklahoma City area)

Utah (Salt Lake City area)

v v v

Virginia (Tri-Cities area in the southwest part of the state)

This expansion builds on Cigna's 2020 footprint, which currently serves more than 500,000 Medicare
customers across 18 states and the District of Columbia. The 2020 footprint includes Alabama, Arizona,
Arkansas, Colorado, Delaware, District of Columbia, Florida, Georgia, Illinois, Kansas, Maryland, Mississippi,
Missouri, New Jersey, North Carolina, Pennsylvania, South Carolina, Tennessee, and Texas.

continued
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2021 Cigna Medicare Highlights continves

New plan names
Last year, we embarked on a new chapter of our Medicare business. We transitioned the Cigna-

HealthSpring brand to Cigna for our Medicare Advantage, Part D, and Texas Medicare-Medicaid plans.

Here's an overview of plan name changes.

Cigna-HealthSpring Advantage (HMO) Cigna Fundamental Medicare (HMO)

Cigna-HealthSpring Preferred AL (HMO) Cigna Preferred AL Medicare (HMO)

Cigna-HealthSpring Preferred Plus (HMO) Cigna Preferred Plus Medicare (HMO)

Cigna-HealthSpring TotalCare (HMO D-SNP) Cigna TotalCare (HMO D-SNP)

Cigna-HealthSpring True Choice (PPO) Cigna True Choice Medicare (PPO)

Cigna-HealthSpring Achieve Plus (HMO C-SNP) Cigna Achieve Medicare (HMO C-SNP)

Cigna-HealthSpring Preferred Part B Savings (HMO) Cigna Preferred Savings Medicare (HMO)

New 2021 ID cards
Cigna Medicare Advantage patients will receive new ID cards with the Cigna logo and updated plan names,

as shown below.

<Plan Name>
<Plan Type>

<Contract/PBP[/segment]>

i-‘;tf-iCignq

<Customer Full Name>

[Services ma i
/ Y require [a refg
[Medicare limiting Charges apgzlljo

Name
D <Customer D> )
re .
Health Plan (80840) [.M.ed&c‘?‘}%(] [Customer Seryice <--Toll Fr,
[Effective Date <Effective Date>] [Provider Services ee Number ---> (TTY 711
PCP <PCP Name> [Authorization[/Refe"a, <Phone NUmber>] )]
PCP Phone  <Phone Number> RxBIN <XXXXXXXZ [Provider Medica Claim]s <<AP o Number:
RXPCN  <XXXXXXX [Pharmacy Help Desk <Pf?grrzsl§1>] b
um er>]

PCP Network <Network>

COPAYS RXGRP  <XXXXXXX>

Specialist  <$xx>
k PCP oo UFr,gent Care <$xx>

[Pharmacy Claim

S
[gent.al Services :ﬁgg::sﬁ]
[Provider Dental Clajms <Address>?mber>]

[<URL>]

Emergency <$xx>
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GENERAL NEWS

CIGNA LAUNCHES EVERNORTH,
A NEW BRAND

We recently took a critical step forward in delivering on our mission to be the leading health
service company in our industry to fundamentally transform and evolve the health experience

for millions of people around the world.

With the launch of Evernorth, a new brand for our growing, high-performing health services portfolio, we
are accelerating delivery of innovative and flexible solutions to meet the diverse needs of health plans,
employers, and government organizations. Tim Wentworth will serve as Chief Executive Officer.

Evernorth brings together our vast array of

health service capabilities, as well as those of
partners from across the health care system. By
coordinating these best-in-class service capabilities
to complement one another and work seamlessly
together, Evernorth will transform them into
comprehensive solutions that drive the most value
for employer groups, customers, and providers in
areas including:

» Pharmacy solutions
Benefits management

Care solutions

v

Behavioral health

v v

Intelligence

What this means to you

While you and your patients may see
communications reflecting the Evernorth brand,
it will not affect ID cards or your day-to-day
business with Cigna, Express Scripts, eviCore
healthcare, or other affiliated companies at
this time. You will continue to leverage existing
systems and methods for submitting claims,
requesting precertification, getting reimbursed,
and other transactional activities. We will continue
to work together to drive improved affordability,
predictability, and simplicity in health care as we
do today.

This is only the beginning

Evernorth represents our belief that health is the
starting point of human progress and potential -

and through Evernorth, we will elevate health for all.

Thank you for your continued partnership as we
embark on this exciting new chapter. If you have
any questions, please call Cigna Customer Service
at 800.88.Cigna (882.4462).
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GENERAL NEWS

EVICORE TO EXPAND ITS
MANAGEMENT OF CERTAIN
CIGNA SERVICES

On February 1, 2021, eviCore healthcare (eviCore),
a Cigna company, will replace CareCentrix (CCx)
in the management of home health, durable
medical equipment (DME), and sleep diagnostic
and therapeutic services. As a result, there will be
some process changes.

Providers will no longer need to contact CCx to
initiate services. Instead, they can contact the
participating provider of their choice for their
patients with Cigna-administered coverage.

In addition, a small number of these services

will require precertification. To access a list of

these services, go to the Cigna for Health Care
Professionals website (CignaforHCP.com) >
Precertification process: Learn what services require
precertification > complete list of services.

Transition of home health and DME services

For home care services, eviCore will provide care
coordination and manage the network, while
Cigna will perform the clinical coverage review
and pay claims.

For now, please continue to contact CCx when
your patients require home care services.

When your patients need these services on or
after February 1, 2021, you may reach out directly
to a home health or DME provider in the eviCore
network. Most home care providers offering
services today to Cigna customers will be in the
Cigna network after February 1, 2021.

We will update our provider directory in early 2021
to include home health and DME providers.

Transition of sleep diagnostic and
therapeutic services

For sleep diagnostic and therapeutic services,
eviCore will perform the clinical coverage review,
while Cigna will continue to manage the network
and pay claims.

The process to order these services for your
patients will not change. Please continue to send
orders for these services to a sleep provider in the
Cigna network.

For a list of participating sleep providers, go to
Cigna.com > Find a Doctor, Dentist or Facility.

Additional information

Affected providers will receive additional
communications throughout the transition. If you
have questions, please contact Cigna Customer
Service at 800.88Cigna (882.4462).
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https://cignaforhcp.cigna.com/app/login
https://www.cigna.com/static/www-cigna-com/docs/individuals-families/master-precertification-list-for-providers.pdf
https://www.cigna.com/
https://hcpdirectory.cigna.com/web/public/consumer/directory

GENERAL NEWS

HOME INFUSION
THERAPY TRANSITION

Effective February 1, 2021, our contract with CareCentrix (CCx) for home infusion therapy services will end. Additional information

As a result., beg'””'r_‘g on.that date,.speqalty and nonsp§6|alty ho‘me |r7fu5|on services wil be avalla.ble Affected providers will receive additional communications throughout the transition. If you have questions,
through Cigna-participating home infusion therapy providers, while eviCore healthcare (eviCore) will also

please call Cigna Customer Service at 800.88Cigna (882.4462).
manage nonspecialty home infusion therapy services

| CONTACT INFORMATION
How to request new services before and after February 1, 2021 TO ORDER HOME INFUSION SERVICES

SERVICE DATES SERVICE CONTACT

When your patients with Cigna-administered | Before February 1, 2021, After February 1, 2021,

coverage require: contact: contact: Begins and ends Specialty
F 1 f ite: i
Specialty home infusion services Accredo, a Cigna specialty Accredo or Cigna- Sg;r ORI infusion Website: CareCentrixPortal.com
pharmacy, or CCx participating specialty Phone: 844.457.9810
pharmacies Begins prior to and  Specialty Accredo
. L . . L continues after infusion ePrescribe: Choose NCPD ID 4436920, 1640 Century Center
Nonspecialty home infusion services CCx Cigna-participating home _
. . . February 1, 2021 Parkway, Memphis, TN 38134.
infusion pharmacies
Fax: Go to the Accredo website (Accredo.com) > Prescribers >
CCx will not approve orders for services that extend beyond January 31, 2021 Referral Forms. Search for the appropriate form (by product or

therapy name, or by specialty condition), download it, and fax it to
the number on the form.

Therefore, we encourage you to use a participating home infusion therapy provider for services needed
after this date. Accredo is an option for specialty home infusion services to help ensure quality care and

promote affordability of medical benefit drugs for your patients. If you need assistance finding a specialty Phone: 866.759.1557
or nonspecialty home infusion provider, please contact eviCore at 800.298.4806. Cigna
Phone: Cigna Customer Service - 800.88Cigna (882.4462) or the
What this means for your patients number on the back of the customer’s ID card
In July 2020, we started contacting your patients who have been receiving specialty home infusion services Begins and ends Nonspecialty CCx
through CCx to help them transition to Accredo so they can continue taking advantage of their in-network prior to February 1, infusion Website: CareCentrixPortal.com
benefits. Any services received from nonparticipating providers will increase out-of-pocket costs. 2021 Phone: 844.457.9810
This process will continue throughout 2020 to ensure we transition all of your patients currently receiving Begins prior to and  Nonspecialty Cigna
care through CCx by February 1, 2021. During this process, a case manager will serve as your primary continues after infusion

Phone: Cigna Customer Service - 800.88Cigna (882.4462) or the

contact, and Accredo will contact you for home infusion orders. February 1, 2021 number on the back of the tomer’s ID card
’ u r e ba cus r's ar
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https://www.carecentrixportal.com/ProviderPortal/homePage.do
https://accredo.com/
https://accredo.com/prescribers/referral_forms
https://www.carecentrixportal.com/ProviderPortal/homePage.do

GENERAL NEWS

CIGNA CENTERS OF EXCELLENCE

FOR HOSPITALS

The Cigna Centers of Excellence (COE) program is
designed to meet the growing customer demand for
information about patient outcomes (quality) and
cost efficiency at hospitals.

We use publicly available, hospital self-reported
claims data sources from the Centers for Medicare

& Medicaid Services (CMS) Medicare fee schedules,
and the Clarify Health Solutions, Inc. platform of
proprietary software applications for commercial,
Medicare Advantage, and managed Medicaid

plans to evaluate this information. We designate
participating hospitals as COEs when they meet
specific patient outcomes and cost-efficiency criteria
by procedure and condition.

Profiles are available to patients with Cigna coverage
for most hospitals participating in our network.

About the hospital profile

Hospitals can receive a score of up to three stars (*)
each, for both patient outcomes and cost-efficiency
measures, for each surgical procedure and medical
condition evaluated.

Those that attain at least five stars (three stars
for patient outcomes and two stars for cost
efficiency, or three stars for cost efficiency and
two stars for patient outcomes) receive the Cigna
COE designation for that procedure, condition, or
condition category.

A hospital’s score may not display in the online
provider directory if:

¥» There is insufficient data available to meet the
patient volume requirement for that procedure or
condition.

» A surgical procedure is not performed or a
condition is not treated at the hospital.

» A reconsideration of quality and/or cost data is
underway.

Because the COE program reflects only a partial
assessment of quality and cost efficiency for select
hospitals, it should not be the sole factor used when
you or your patients make decisions about where
they should receive care. We encourage individuals
to consider all relevant factors, and to speak with
their treating physician when selecting a hospital.

*The 2021 Cigna Centers of Excellence Methodology will be available starting in early November 2020.
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Timeline for COE designations and displays

DATE DESCRIPTION

October 30, 2020
November 30, 2020

January 1, 2021

Hospitals notified about their 2021 results.
Hospital reconsideration requests are due.

COE information available in the provider directory on Cigna.com

and myCigna.com.

Timing of reconsideration requests

We must receive reconsideration requests by
November 30, 2020 for the updated information
to appear on the initial display of the Cigna COE
designations on January 1, 2021. We will still
process requests we receive after this date, and
any amended results will be reflected in the next
directory update.

Additional information

Please contact your Cigna Contractor to obtain

your hospital COE results. After you review your
information, you can request that we reconsider your
results or correct inaccuracies. Submit additional
information for review and reconsideration by:

» Email: PhysicianEvaluationinformationRequest@
Cigna.com

» Fax; 866.448.5506

The facility name, Taxpayer Identification Number,
and contact information must be included. A Cigna
Network Clinical Manager or Specialist will contact
you to discuss the request, initiate the Selection
Review Committee review process, and provide a
written response within 30 days of receiving the
reconsideration request.

To learn more about the methodology we use

to determine COE designations, please review

our white paper. Go to the Cigna for Health Care
Professionals website (CignaforHCP.com > Get
questions answered: Resource > Medical Resources >
Commitment to Quality > 2021 Cigna Centers

of Excellence Methodology,* or call Cigna

Customer Service at 800.88Cigna (882.4462)

to obtain a copy.
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https://my.cigna.com/web/public/guest
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https://cignaforhcp.cigna.com/app/login
https://static.cigna.com/assets/chcp/resourceLibrary/medicalResourcesList/medicalCommitment2Quality.html

GENERAL NEWS

HIGH-TECH RADIOLOGY SITE OF
CARE MEDICAL NECESSITY REVIEW
PROGRAM EXPANSION

On August 1, 2020, we expanded our precertification requirements for computed tomography scans and
magnetic resonance imaging to include a medical necessity review of the procedure and site of care when
an outpatient hospital setting is requested. This requirement applies for customers with fully insured benefit
plans and those who are covered under the Cigna employees benefit plan.*

We review requests to ensure these customers receive coverage for an appropriate site of care, such as a
freestanding facility, rather than an outpatient hospital setting (when available), except in situations where the
use of an outpatient hospital setting is medically necessary.**

Beginning January 1, 2021, this requirement will also apply to customers with Individual & Family Plans.

What this means to you and your patients
with Cigna plans

eviCore healthcare (eviCore) will approve:

» Precertification requests that include an
appropriate site of care, and are in accordance
with the terms of our coverage policy and the
customer’s benefits.

» An outpatient hospital setting when medically
necessary, as defined in the Site of Care: High-tech
Radiology policy and the customer’s benefit plan.

Standard Cigna benefit plans will not cover a service
or a site of service as medically necessary if there is a
lower-cost clinically equivalent alternative.

How to submit precertification requests

You can continue to submit precertification requests
to eviCore by logging in to the eviCore website
(eviCore.com > PROVIDERS).

View the updated policy

You can access the updated Site of Care: High-tech
Radiology policy by going to the Cigna for Health
Care Professionals website (CignaforHCP.com) >
Review coverage policies: information on Cigna
standard health coverage plan provisions > Medical
and Administrative A-Z Index: View Documents >
Site of Care: High-tech Radiology - (0550).

*We may not review the site of care in all geographic markets, pending requlatory approval and/or network considerations.

** Some hospitals with competitive costs will be exempt from the site-of-care review.
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Additional information

Please use the contact information below to learn more.

TO LEARN MORE ABOUT: CONTACT:

Our dedicated program website:
www.eviCore.com/resources/healthplan/Cigna

High-Tech Radiology Site of Care program

eviCore: 888.693.3297 (7:00 a.m. to 7:00 p.m. ET) or
clinical guidelines at eviCore.com

Precertification of high-tech radiology services

Benefits eligibility and coverage
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https://static.cigna.com/assets/chcp/pdf/coveragePolicies/medical/mm_0550_coveragepositioncriteria_SOC_HTR.pdf

GENERAL NEWS

PATIENT CONCERNS

OR COMPLAINTS
ACCOUNTABLE CARE PROGRAM G s e
ROSTER ENHANCEMENT: ADD pertonts b e sy of e

important to address and resolve the patient’s

PROVIDERS MONTHLY s e e

responding within the requested time period,
you'll also be adhering to your provider contract

Groups that participate in a Cigna Collaborative Care® Accountable Care program* can now add providers to it Cigne.

their program roster on a monthly basis instead of quarterly. This became effective on July 1, 2020, and is in Information requests may include:

addition to a group’s continued ability to remove providers monthly from the roster. » A response from your office about the complaint.
To request monthly roster updates, follow your current process. Your Experience Manager or Experience » Medical records (please coordinate with
Consultant will continue submitting your update requests for entry into our system. As a reminder, update your copy services to ensure timely release
requests must be made 30 days in advance of the effective date. of records).

Please view the Roster Guidelines and Process for additional details. |f you have any questions about how we handle

patient concerns or complaints, please call Cigna
Customer Service at 800.88Cigna (882.4462).

Additional information

To learn more about our quality programs, visit the
Cigna for Health Care Professionals website
(CignaforHCP.com) > Get questions answered:
Resource > Medical Resources > Commitment to
Quality > Quality.

We appreciate the quality care you provide to
our customers, and your continued assistance
with our quality programs.

* Referred to as Collaborative Accountable Care (CAC) in contract documents. Cigna Collaborative Care programs are Cigna's approach to achieving the same population health goals as
Medicare accountable care organizations (ACOs).
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https://static.cigna.com/assets/chcp/pdf/resourceLibrary/global/roster-guidelines-and-process.pdf
https://cignaforhcp.cigna.com/app/login
https://static.cigna.com/assets/chcp/resourceLibrary/medicalResourcesList/medicalcommitment2Quality/commit2QualityQualityListing.html

GENERAL NEWS

CIGNA SHARED
ADMINISTRATION REPRICING

Cigna provides health benefit services to more than 550,000 people covered by Taft-Hartley Trust Funds and
Federal Employee Health Benefit (FEHB) plans as part of our shared administration repricing program.

For these relationships, we provide access to the Cigna network, perform medical management and
utilization reviews, reprice claims according to our contracted rates and claims logic, provide contract dispute
resolution, and may offer clinical appeals management and other outpatient care management.

When administering these plans for your patients with Cigna-administered coverage, please refer to the

chart below.
TOPIC CONTACT INFORMATION
» Contract pricing inquiries 800.549.8909, 8:00 a.m.-6:00 p.m. ET, Monday-Friday

» Claim pricing status

» Claim submissions: Paper and electronic Cigna payer ID: 62308
PO Box 188004, Chattanooga, TN 37422-8004

» Prior authorizations Telephone number or address on your patient’s ID card

» Precertifications

» Eligibility Third-party administrator telephone number or address on
» Benefits your patient’s ID card

» Claim payment status

» Electronic remittance advice (ERA) and

electronic funds transfer (EFT) enrollment

Additional information

To learn more about shared administration benefits, visit the Cigna for Health Care Professionals website
(CignaforHCP.com) > Get questions answered: Resource > Medical Resources > Medical Plans and Products >
Shared Administration.
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https://static.cigna.com/assets/chcp/pdf/resourceLibrary/global/roster-guidelines-and-process.pdf
https://cignaforhcp.cigna.com/app/login
https://static.cigna.com/assets/chcp/resourceLibrary/medicalResourcesList/medicalPlansAndProduct/medicalPlansProductsThirdPartyAccountListing.html

REGIONAL NEWS

CIGNA AND PRIORITY HEALTH
ANNOUNCE NEW STRATEGIC
ALLIANCE

Cigna is entering into a new Strategic Alliance Cigna’'s other strategic alliances
with Priority Health that will become effective on
January 1, 2021. Through this partnership, we will
be able to leverage the best capabilities of both
organizations, and deliver a health care experience
in Michigan’s Lower Peninsula that is more

CIGNA + OSCAR PLANS LAUNCHED
IN GEORGIA AND TENNESSEE

In addition to Priority Health, Cigna has strategic
alliance relationships with:

» Tufts Health Plan/CareLink® (Massachusetts
and Rhode Island)

On October 1, 2020, new Cigna + Oscar plans became available in Metro-Atlanta, Georgia, and Tennessee. predictable and simplified for providers > Health Alliance Plan (Southeast Michigan)
These plans bring together the power of Cigna’s national and local provider networks - Open Access Plus and customers. » HealthPartners® (Minnesota, North Dakota, and
anq .I_oca|P|u5® - anq Oscar Health’s innovative digiFaI custome.r experience. They provide a gquality, cost- What this means to providers in Michigan’s Western Wisconsin)

efficient health solution for small employer groups in these regions. Lower Peninsula » MVP® Health Care (Upstate New York, Western

What this means to providers

If you participate in the Open Access Plus or
LocalPlus networks in these service areas, your care
will be considered in-network for your patients who
have Cigna + Oscar plans.

To confirm your network participation, visit Oscar’s
online directory at CignaOscar.com/search or call
Oscar Health Customer Service at 855.672.2755
and select option 4.

More information

To learn more about Cigna + Oscar plans, please
access the resources listed below.

» Cigna + Oscar provider website (CignaOscar.com)

» Oscar Health Customer Service: 855.672.2755
and select option 4

You can also find additional administrative guidelines
and program requirements for Cigna + Oscar plans
at CignaOscar.com. They are supplemental to

the Cigna Reference Guides. See page 38 for

more information.
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On January 1, 2021, your current patients with
Cigna plans will begin to access in-network medical
care from providers who participate in the Priority
Health network. Your care will continue to be
considered in-network for these patients if you are
contracted with Priority Health before this date.

To confirm that you have an agreement with
Priority Health, go to the Priority Health website
(PriorityHealth.com) > Member > Getting Care >
Find a Doctor > Skip login. Enter your location and
conduct a search. If you participate in the Priority
Health network, your name will appear. You may
also obtain this information by calling Priority
Health Customer Service at 800.942.4765.

To initiate contracting with Priority Health, go to
PriorityHealth.com > Provider > Join our networks.

Please note that in Michigan’s Upper Peninsula,
patients with Cigna plans will continue to access
in-network medical care from providers who
participate in the Upper Peninsula Health

Plan network.

New York, and Bradford County, Pennsylvania)

For more information

To learn more about Cigna's strategic alliances, visit
the Cigna for Health Care Professionals website
(CignaforHCP.com) > Resources > Medical
Resources > Medical Plans and Products >
Strategic Alliances.

To learn more about our new strategic alliance with
Priority Health, please access one of the resources
listed below.

» Frequently Asked Questions
» Quick Reference Guide

» Cigna Provider Services Unit: 800.88Cigna
(882.4462).

LA EEEEEEE EBE



http://www.cignaoscar.com/search
https://www.hioscar.com/business/cigna?redirect=cignaoscar.com&
https://www.hioscar.com/business/cigna?redirect=cignaoscar.com&
https://www.priorityhealth.com/
https://web.healthsparq.com/healthsparq/public/#/one/insurerCode=PH_I%26brandCode=PH
https://www.priorityhealth.com/
https://www.priorityhealth.com/provider/manual/join-our-networks
https://cignaforhcp.cigna.com/app/login
https://static.cigna.com/assets/chcp/resourceLibrary/medicalResourcesList/medicalPlansAndProduct/medicalPlansProductsStrategicAlliances.html
https://static.cigna.com/assets/chcp/pdf/resourceLibrary/global/PriorityHealth-StrategicAlliance_FAQ.pdf
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REGIONAL NEWS

TIMELY ACCESS TO CARE'

ALL CARE

Average wait time in the office Appointment rescheduling

CALIFORNIA PROVIDER ACCESS 30 D OMPTLY
AND AVAILABILITY

EMERGENT OR HIGH RISK

As a provider, you want your patients to be healthy and satisfied with your care. When they receive the right I M M E D IATE

care at the right time, it can result in better outcomes and an improved care experience for both you and Office visit, emergency room, or ambulance (call 9-1-1)
your patient.

URGENT CARE

The State of California Department of Managed Health Care (DMHC) has set forth guidelines to help ensure
individuals receive timely access to medical and behavioral care based on their needs. Timely access is also Prior authorization Prior authorization

part of your Cigna contract. not required by health plan required by health plan

Annual Provider Appointment Access and Availability Survey 2 ‘0 4
days days

Each year, we require network-participating providers to complete a Provider Appointment Availability Survey
(PAAS) to help ensure compliance with the California DMHC and Cigna access standards for all care.

NON-URGENT CARE

Resources
Please refer to the infographic to the right. We encourage you to use this as a visual reminder of access to Doctor Appointment
care standards for your patients based on their needs. To learn more about California access standards, refer PRIMARY CARE PHYSICIAN SPECIALTY CARE PHYSICIAN
to the resources below. 0 10
RESOURCE GO TO: G 10 business days G 15 business days
Cigna Reference Guide for participating Cigna for Health Care Professionals website
. ) .
physicians, hospitals, ancillaries, and other health  (CignaforHCP.com) > Resources > Reference Guides Mental Health Appointment Appointment
care providers (California). > Medical Reference Guides > Health Care Professional (nonphysician®) (ancillary provider®)
Reference Guides > California. (Login required) mlm'n 1 o —Hh

. . . . . G business days G 15 business days
California Department of Managed Health DMHC.CA.gov > Health Care in California > Your Health € y € y
Care website Care Rights > Timely Access to Care
Questions? 1. The Urgent and Non-Urgent Care sections of this infographic are reproduced and printed with the permission of the California Department of Managed Health Care. DMHC.CA.gov >

Health Care in California > Your Health Care Rights > Timely Access to Care.
We're here to help. Call us at: 800.88Cigna (882.4462) 2. Six hours for mental health, non-life-threatening emergency care (National Committee for Quality Assurance required access standards).
' ' : ' ' 3. Examples of non-physician mental health providers include counseling professionals, substance abuse professionals, and qualified autism service providers.
4. Examples of non-urgent appointments for ancillary services include lab work or diagnostic testing, such as mammograms or MRIs, and treatment of an illness or injury such as
physical therapy.
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https://cignaforhcp.cigna.com/app/login
http://dmhc.ca.gov/
https://www.dmhc.ca.gov/HealthCareinCalifornia/YourHealthCareRights/TimelyAccesstoCare.aspx
https://www.dmhc.ca.gov/HealthCareinCalifornia/YourHealthCareRights/TimelyAccesstoCare.aspx

REGIONAL NEWS

MA LAW: PAIN MANAGEMENT
ALTERNATIVE SERVICES
AND MEDICATIONS

In compliance with Massachusetts statute ALM General Law ch. 175, § 47KK and Bulletin 2019-06, Cigna sent
an email in September 2020 to providers in Massachusetts about possible alternative pain management
services and medications that may be covered for their Cigna patients.

Listed below are some of our non-medication services and medications that may be alternative treatments
to opioids for treating pain. These are typically covered under Cigna's plans, but providers will need to check
coverage for each patient as coverage will vary based on the patient’s plan.

Non-medication treatment alternatives
for pain:

Non-opioid medication alternatives for pain:

Anticonvulsants

» Acupuncture Antidepressants

Chiropractic Cortico-steroids
COX-2 inhibitors

NSAIDs

Cognitive behavioral therapy
Interventional pain management nerve block

Nutritional counseling Skeletal muscle relaxants

v VY v

Occupational therapy Topical analgesics

Osteopathic manipulation medicine

Physician medicine/rehabilitation

v VY Y Y VY VY v v

Physical therapy
Spine surgery

Transcutaneous electrical nerve stimulation
(TENS) unit
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Questions?

For more information about these and other possible alternatives to treating pain, access the resources below.

RESOURCE GO TO:

Create a Pain Plan for Opioid Safety
web page

Cigna.com/HelpWithPain

Opioid Resources web page Cigna for Health Care Professionals website (CignaforHCP.com) >
Get Questions Answered: Resource > Pharmacy Resources >

Pharmacy Clinical Programs> Opioid Resources
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https://www.cigna.com/helpwithpain/
https://cignaforhcp.cigna.com/app/login
https://static.cigna.com/assets/chcp/resourceLibrary/pharmacyResources/pharmEnhancedNarcoticTherapyManagement.html

COMMUNITY NEWS

CIGNA SUPPORTS PIPELINE OF
SUPERINTENDENTS OF COLOR

In the face of a global pandemic and heightened visibility of racism and discrimination, communities across
the United States are grappling with structural barriers to the success of students of color.

Superintendents of color have unigue
challenges, as we are often tapped to

lead high-needs districts where millions of
underserved students of color are in need
of a high-quality education, and where
resources are scarce. It takes skill, courage,
and an unconguerable spirit to improve
outcomes under these conditions.

— Shawn Joseph, Ed.D., Assistant Professor
Educational Leadership and Policy Studies;
Co-director, AASA-Howard University
Urban Superintendents Academy

Cigna grant supports education for
superintendents of color

In July 2020, Cigna awarded a $250,000 grant to the
AASA-Howard University Urban Superintendents
Academy, a school of the Howard University

School of Education. For the past five years,

this academy has tackled systemic inequality in
education by creating a pipeline of superintendents
of color - who represent less than five percent of
superintendents in America - specifically trained to
lead urban school districts. The grant will be used to
expand this program.
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“We are grateful for the commitment that Cigna has
shown in supporting urban education,” declared
Dawn Williams, Ph.D., Dean, Howard University
School of Education. “We find ourselves fighting

a history of structural racism, while also trying to
safeguard our health against a global pandemic.
With the generous support of Cigna, we can attract,
develop, and retain cohorts of educational leaders
to advance change for more equitable and just
school systems.”

Howard University’s legacy in tackling issues
of diverse populations

Howard University is widely known for its legacy
in tackling some of the world’'s most challenging
issues facing diverse populations. Its commitment
to training leaders who work to combat inequality
is evidenced by its innovative programs,
accomplished alumni, and prestigious faculty.

Standing together to elevate a diverse next
generation of leaders

“Cigna has a resolute belief in the power of
diversity and inclusion, and a long-standing
commitment to health equity and equality
that creates healthy and vibrant communities
for all” stated Mike Triplett, President, Cigna
U.S. Commercial business. “In partnership with

FOURTH QUARTER 2020

Howard University, Cigna is standing together to elevate a diverse next generation of leaders for our urban
school communities. Education is the path to economic prosperity for many. We are proud to partner on this
initiative and wish the program participants every success in their studies and in their future careers.”

About the Cigha Foundation

The Cigna Foundation, established in 1962, is a private foundation funded by contributions from
Cigna Corporation (NYSE:CIl) and its subsidiaries. The foundation supports organizations sharing
its commitment to enhancing the health of individuals and families, and the well-being of their
communities, with a special focus on health equity and community health navigation.
Cigna.com/Foundation.

About Howard University

Howard University, founded in 1867, is a private, research university comprising 13 schools and
colleges. Students pursue studies in more than 120 areas leading to undergraduate, graduate, and
professional degrees. The University produces more on-campus African-American Ph.D. recipients
than any other university in the United States. Howard.edu.
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https://www.cigna.com/about-us/corporate-responsibility/cigna-foundation
http://www.howard.edu/
https://newsroom.howard.edu/newsroom/static/8381/innovative-school-education-program-prepares-diverse-educators-superintendent" AASA-Howard University Urban Superintendents Academy
https://newsroom.howard.edu/newsroom/static/8381/innovative-school-education-program-prepares-diverse-educators-superintendent" AASA-Howard University Urban Superintendents Academy

HELPFUL REMINDERS

MARKET MEDICAL EXECUTIVES
CONTACT INFORMATION

Cigna Market Medical Executives (MMEs) are an important part of our relationship with providers.

CLICK ON YOUR REGION TO VIEW YOUR MME CONTACT INFORMATION They provide personalized service within their local regions and help answer your health care-related

guestions. MMEs cover specific geographic areas, so they are able to understand the local community

and service.

NATIONAL

Peter McCauley, Sr., MD, CPE
Clinical Provider Engagement &
Value-Based Relationships

Jennifer Gutzmore, MD
Clinical Strategy & Solutions

NORTHEAST REGION

Reasons to call your MME

» Ask questions and obtain general information
about our clinical policies and programs.

SOUTHEAST REGION

» Ask questions about your specific practice
and utilization patterns.

» Report or request assistance with a quality
concern involving your patients with
Cigna coverage.

nuances in health care delivery. This allows them to provide you with a unique level of support

312.648.5131

818.500.6459

» Request or discuss recommendations

for improvements or development of
our health advocacy, affordability, or
cost-transparency programs.

» Recommend specific physicians or facilities

for inclusion in our networks, or identify clinical
needs within networks.

» lIdentify opportunities to enroll your patients

in Cigna health advocacy programs.
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HELPFUL REMINDERS

UPDATED CIGNA
REFERENCE GUIDES
NOW AVAILABLE

The Cigna Reference Guides for participating physicians, hospitals,
ancillaries, and other providers contain many of our administrative
guidelines and program requirements, and include information
pertaining to participants with Cigna “G” ID cards.

Access the guides

You can access the reference guides by logging in to the Cigna for
Health Care Professionals website (CignaforHCP.com) > Resources

> Reference Guides > Medical Reference Guides > Health Care
Professional Reference Guides. You must be a registered user to access
this site. If you are not registered for the website, click Register.
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USE THE NETWORK

Help your patients keep medical costs down by referring them to providers in our network. Not only is that helpful to them, but it’s good for
your relationship with Cigna, as it’s required in your contract. There are exceptions to using the network - some are required by law, while
others are approved by Cigna before you refer or treat the patient.

Additionally, your contract with Cigna requires you to use pharmacies in the Cigna network for specialty medications, including injectable
medications, whenever possible. Accredo, a Cigna company, is a nationwide pharmacy for specialty medications and can be used when
medically appropriate.

Of course, if there’s an emergency, use your professional discretion.

Referral reminder: New York and Texas

If you are referring a patient in New York or Texas to a nonparticipating provider (e.g., laboratory, ambulatory surgery center), you are
required to use the appropriate Out-of-Network Referral Disclosure Form.

» New York providers
» Texas providers

For a complete list of Cigna-participating physicians and facilities, go to Cigna.com > Find a Doctor, Dentist or Facility. Then, select
a directory.
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https://cignaforhcp.cigna.com/app/login
https://cignaforhcp.cigna.com/app/registration/lob
https://www.cigna.com/static/www-cigna-com/docs/out-of-network-referral-disclosure-form.pdf
https://www.cigna.com/static/www-cigna-com/docs/texas-out-of-network-referral-disclosure-form.pdf
https://www.cigna.com/
https://hcpdirectory.cigna.com/web/public/consumer/directory

HELPFUL REMINDERS

PATIENT REVIEWS

As a reminder, verified patient reviews* display in
providers’ profiles in the myCigna.com directory.
New reviews are published on an ongoing basis.

Reviews are verified

A Cigna customer is only sent a survey - and can
only leave a review for a provider - after a claim has
been processed for care received from that provider.
This verifies that the review is from a provider’s
actual patient. We anticipate that customers will
value these verified patient reviews over unverified
reviews from third-party websites, and use them as a
trusted source when choosing health care providers.

How patient reviews works

After a preventive care or routine office visit,
customers may receive an email with a single
guestion that asks about their recent health care
experience. Their response (or “review”) is vetted

to ensure it meets certain editorial guidelines. For
example, the language cannot violate protected
health information rules or contain profanity.
Reviews that meet the guidelines will be published in
the myCigna.com directory.

* For U.S. customers only.

REMINDERS

Who receives reviews?

Patient reviews are available in our online
directory for both network-participating and
nonparticipating providers.

Chiropractors

Dermatologists

Ophthalmologists

Pediatricians

Podiatrists

Primary care providers

v Y v

How to access your reviews

» Log in to the Cigna for Health Care Professionals
website (CignaforHCP.com). If you are not a
registered user of the website, go to
CignaforHCP.com > Register.

» Under Latest Updates, view your patient reviews
and click “Learn more” for instructions.

» You will be instructed to ask your practice’s
website access manager for access to patient
reviews.

Once your website access manager grants you

(or the staff member you designate) access to the
reviews, you can view them at any time by logging
in to CignaforHCP.com > Working with Cigna >
Patient Reviews.

**This tab will appear on all provider profile pages, but will only display reviews if they are available.
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QUICK GUIDE TO CIGNA ID CARDS

The Quick Guide to Cigna ID Cards contains » Click View the Back to see the reverse side
samples of the most common customer ID cards, of the card.

along with detailed line-item information. You can » Click About This Plan to read more about the
view it using our online interactive ID tool or as

plan associated with this ID card.

a PDF. - : '
» Click View Another Card Type to view a

To access the guide: different sample ID card.

» Go to Cigna.com > Health Care Providers > » If you prefer to view a PDF of the guide, click
Coverage and Claims > Cigna ID Cards. View the print version of the guide.

» You'll see sample images of the most common
ID cards.

Other information you can access

On every screen of the ID card tool, you can
» To view only the cards for certain plan types, click a green tab for more information about:
click Filter Cards by Category and select one or ’

more plan types - such as Managed Care Plans,
Individual & Family Plans, or Strategic Alliance
Plans - from the categories that appear.

The myCigna® App.*
» More ways to access patient information
when you need it.

» Important contact information.
» Choose the image that matches your patient’s

ID card; the selected sample ID card will appear.

» Hover over each number shown on the card for Click here to use the digital ID card tool.
more details about that section, or read the key

on the right-hand side of the screen.

*The downloading and use of the myCigna App is subject to the terms and conditions of the App and the online stores from which it is downloaded. Standard mobile phone carrier
and data usage charges apply.

If you believe a review is inappropriate or inaccurate, you can request that it be removed. If we agree, we
will remove it immediately. But if we determine that it does meet editorial guidelines, the review will not be
removed. However, you will be given the opportunity to respond to the review directly.

How customers access patient reviews

When customers search our online directory and select a provider’s profile, they can click the Reviews tab**
to view the recommendation rate, patients’ comments, and the provider’s responses.

Questions?

Please call your Cigna Provider Relations contact or call Cigna Customer Service at 800.88Cigna (882.4462).
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https://cignaforhcp.cigna.com/app/registration/lob
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HELPFUL REMINDERS

URGENT CARE FOR
NONEMERGENCIES

People often visit emergency rooms for non-life-threatening situations,
even though they usually pay more and wait longer. Why? Because they
often don’t know where else to go.

You can give your patients other, often better, options. Consider
providing them with same-day appointments when it’s an urgent
problem. And when your office is closed, consider directing them to
a participating urgent care center rather than the emergency room,
when appropriate.

For a list of Cigna’s participating urgent care centers, view our Provider
Directory at Cigna.com > Find a Doctor, Dentist or Facility. Then,
choose a directory.
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VIEW DRUG BENEFIT DETAILS USING
REAL-TIME BENEFIT CHECK

Real-time benefit check gives you access to patient-specific drug benefit information through your electronic medical record (EMR) or
electronic health record (EHR) system during the integrated ePrescribing process. If you are a provider treating military beneficiaries, you
also have access to patient-specific drug benefit information through your EMR or EHR system.

This service enables you to access drug benefit details, including:

» Cost share.

» Therapeutic alternatives with cost shares.

» Coverage status (e.g., prior authorization, step therapy, quantity limits).
?

Channel options (i.e.,, 30- and 90-day retail, and 90-day mail).

EMR or EHR system requirements

To access real-time benefit check, you must have the most current version of your vendor’s EMR or EHR system, and the system must be
contracted with Surescripts®. For more information and to get started, contact your EMR or EHR vendor.
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HELPFUL REMINDERS

KNOWLEDGE WITH
CAREALLIES
EDUCATION SERIES

CareAllies”, a Cigna business, continues to help increase your
value-based care knowledge through Valuable Insights, a free, online
education series. This series enables you to:

» Earn AMA PRA* Category 1 Credits™ with Valuable Insights
on-demand webcasts.**

» Learn quickly and on the go with Valuable Insights podcasts.

» Get industry updates from subject matter experts with Valuable
Insights alerts.

To obtain access to Valuable Insights, including past resources and
notifications when new resources are posted, visit the Valuable Insights
registration page. If you have questions, email info@CareAllies.com.

* American Medical Association Physician’s Recognition Award.

**This activity has been planned and implemented in accordance with the accreditation requirements and policies of the
Accreditation Council for Continuing Medical Education (ACCME) through the joint providership of the Illinois Academy
of Family Physicians and CareAllies. The lllinois Academy of Family Physicians is accredited by the ACCME to provide
continuing medical education for physicians.
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RESOURCES TO ENHANCE INTERACTIONS
WITH CULTURALLY DIVERSE PATIENTS

If you serve a culturally diverse patient
population, check out the Cigna Cultural
Competency and Health Equity Resources
web page. It contains many resources

to help you and your staff enhance your
interactions with these patients. The website
is easy to navigate, streamlined to help you
find the information you need quickly, and
mobile friendly.

eCourses, language assistance
services, and more

Listed below are some of the resources
available to Cigna-contracted providers.

eCourses

The following eCourses can help you

learn cultural competency overall best
practices, and gain a deeper understanding
of Hispanics and South Asians in the
United States.

» Developing Cultural Agility

» Developing Culturally Responsive Care:
Hispanic Community (three-part series)

» Diabetes Among South Asians in the
U.S., including translated (Hindi, Nepali,
and Urdu) patient education materials
on culturally appropriate dietary
modifications (three-part series)

Language assistance services

Cigna-contracted providers may utilize
discounted rates of up to 50 percent for
language assistance services such as
telephonic and face-to-face interpretations,
as well as written translations, for their
eligible patients with Cigna coverage.

These savings are made possible through
Cigna's negotiated contracts with
professional language assistance vendors.
Your office works directly with the vendor
to schedule and pay for services.

In addition, providers in California may
access the California Language Assistance
Program for Providers and Staff. The
training includes education on California
Language Assistance Program regulations,
provider responsibilities, how to access
language services for your patients with
Cigna coverage, and more.

CultureVision

As a practitioner, it’'s impossible to know
everything about every cultural community
you serve. However, learning how and
what to ask may increase the likelihood
that you will obtain the information you
need, and enhance rapport and adherence.
Gain these insights through CultureVison™,
which contains up-to-date, culturally
relevant patient care for more than

60 cultural communities.

You can access CultureVision directly at:

CRCultureVision.com
Login: CignaHCP
Password: Doctors123*

Additional resources

Many other resources are available on the
website, including articles, presentations,
white papers, podcasts, and self-
assessments. You can find them in the All
Resources section of the website.

Visit today

Go to Cigna.com > Health Care Providers >
Provider Resources > Cultural Competency
and Health Equity. Check back often for
newly added resources.

GENDER DISPARITY TRAINING
FOR CME CREDIT

A new eCourse, “Gender Disparity in
CAD and Statin Use,” is now available
for Continuing Medical Education
(CME) credit. Physicians who take this
training can earn a maximum of 0.50
AMA PRA* Category 1 credit™.

The eCourse will:

» Increase your awareness of gender
disparities in statin use by women
who have coronary artery disease
(CAD).

» Introduce you to the most current
understanding of CAD risk factors
affecting women’s health.

» Share a summary of research.

» Discuss how implicit bias affects
patients.

To access the eCourse, visit Cigna.com
> Health Care Providers > Provider
Resources > Cultural Competency and
Health Equity > Cultural Competency
Training.

* American Medical Association Physician’s Recognition Award (AMA
PRA) is an award issued by the AMA to physicians who have met
certain CME requirements.
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HELPFUL REMINDERS

HAVE YOU MOVED RECENTLY?
DID YOUR PHONE NUMBER CHANGE?

Check your listing in the Cigna » An online Provider Demographic Update Form
provider directory will appear that will be prepopulated with the
We want to be sure that Cigna customers have information for your practice that currently
displays in our provider directory. You can easily
review the prepopulated fields, determine if

the information is correct, make any necessary

changes, and submit the form to us electronically.

the right information they need to reach you when
seeking medical care. We also want to accurately
indicate whether you are accepting new patients.

It’s easy to view and submit demographic

changes online Update your email address to continue

receiving Network News and alerts
» Log in to the Cigna for Health Care

Professionals website (CignaforHCP.com) >
Working With Cigna.
» Go to the Update Demographic Information

section, and click Update Health Care
Professional Directory.

Please make sure that your email address is
updated so that you won’t miss any important
communications, such as Network News, alerts,
and other emails. It only takes a moment. Simply
log in to CignaforHCP.com. At the top of the page
next to your name, click the drop-down menu.

If you don't see this option, ask your website Select Settings & Preferences to make the updates.
access manager to assign you access to the You can also change your phone number, job role,
functionality to make updates. If you don’t know address, and password here.

who your website access manager Is, log in to
CignaforHCP.com > Settings and Preferences >
Online access > View TIN access. Select your TIN,
the name of your website access manager(s) will
be provided at the bottom of the screen.
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HELPFUL REMINDERS

GET DIGITAL ACCESS
TO IMPORTANT
INFORMATION

Would you like to reduce paper

use in your office? Sign up now to
receive certain announcements and
important information from us right
to your inbox.

When you register for the Cigna for
Health Care Professionals website
(CignaforHCP.com), you can:

» Share, print, and save -
electronic communications
make it easy to circulate copies.

» Access information anytime,
anywhere - view the latest
updates and time-sensitive
information online.

When you register, you will
receive some correspondence
electronically, such as Network
News.* You will still receive
certain other communications
by regular mail.

If you are a registered user, please
check the My Profile page to make
sure your information is current.

If you are not a registered user

but would like to begin using the
welbsite and receive electronic
updates, go to CignaforHCP.com
and click Register.

* QualCare providers must sign up to receive Network News electronically at Cigna.com/networknews.
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ACCESS THE ARCHIVES

To access articles from previous issues of Network News, visit Cigna.com > Health Care Providers > Provider Resources > Cigna
Network News for Providers.

LETTERS TO THE EDITOR

Thank you for reading Network News. We hope you find the articles informative, useful, and timely, and that you’'ve explored our
digital features that make it quick and easy to share and save articles of interest.

Your comments or suggestions are always welcome. Please email NetworkNewsEditor@Cigna.com or write to Cigna, Attn: Provider
Communications, 900 Cottage Grove Road, Routing B7NC, Hartford, CT 06152.

W%,

¢ Cigna.

All Cigna products and services are provided exclusively by or through operating subsidiaries of Cigna Corporation, including Cigna Health and Life Insurance Company, Connecticut General Life Insurance Company, Cigna Behavioral Health, Inc., and HMO or service company
subsidiaries of Cigna Health Corporation. The Cigna name, logo, and other Cigna marks are owned by Cigna Intellectual Property, Inc. All pictures are used for illustrative purposes only.
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